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HANDS-ON ACTIVITIES 
 

Investigating Dissolved Oxygen 
• Optical DO Probe 

 
Acid Rain and its Effect on Surface Water 

• pH Probe 
 

Freezing of Ocean Water 
• Stainless Steel Temperature Probe 

• Go Direct Temperature 
 

Insulation Study 
• Stainless Steel Temperature Probe 

• Go Direct Temperature 





 Environmental Science Lab Books from Vernier 

 

Book  Grade Level Features 

Investigating 
Environmental Science 

Through Inquiry 

 
 High school 
 College 

 
 Correlated to AP and IB Standards 
 34 inquiry based investigations 
 Available as an iBook 

Renewable Energy 
with Vernier 

 
 High school 
 College 

 
 NGSS aligned 
 26 experiments  
 Includes experiments in wind energy 

and solar energy 

Earth Science with 
Vernier 

 
 Middle school 
 High school 
 College 

 
 33 experiments 
 Includes experiments in soil analysis, 

water quality, meteorology, and energy  

Water Quality with 
Vernier 

 
 Middle school 
 High school 
 College 

 
 18 water quality tests, including pH, 

TDS, and dissolved oxygen 
 Determing the Water Quality Index 

(WQI) of a local body of water 
 comprehensive introduction providing 

important background information  

Investigating Wind 
Energy 

 
 K–8 

 
 NGSS aligned 
 10 experiments and a culminating 

engineering project 
 Investigate variables that affect power 

output of wind turbines 

Investigating Solar 
Energy 

 
 K–8 

 
 NGSS aligned 
 9 experiments and 2 culminating 

engineering projects 
 Explore variables that affect solar panel 

output 
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Dissolved Oxygen in Water 
(Optical Dissolved Oxygen Probe) 

Aquatic life depends upon oxygen dissolved in water, just as organisms on land rely upon 
oxygen in the atmosphere. Molecular oxygen is used by organisms in aerobic respiration where 
energy is released during the combustion of sugar in the mitochondria. Without sufficient 
oxygen, they suffocate. Some organisms, such as salmon, mayflies, and trout, require high 
concentrations of oxygen in the water. Other organisms, such as catfish, midge fly larvae, and 
carp can survive with much less oxygen. 

Oxygen dissolves at the interface between the water and the air or when aquatic autotrophs 
release oxygen as a byproduct of photosynthesis. Abiotic factors including temperature and 
pressure influence the maximum amount of oxygen that can be dissolved in pure water. Biotic 
life also influences the amount of oxygen that is dissolved.  

The following table indicates the oxygen and temperature tolerance level of selected animals. 
The quality of the water can be assessed with fair accuracy by observing the aquatic animal 
populations in a stream. These assessments are based on known dissolved oxygen tolerance. If a 
stream has only species that can survive at low oxygen levels, it is expected to have low oxygen 
levels. 

Table 1 

Animal Temperature range  
(°C) 

Minimum dissolved oxygen  
(mg/L) 

Trout 5–20 6.5 

Smallmouth bass 5–28 6.5 

Caddisfly larvae 10–25 4.0 

Mayfly larvae 10–25 4.0 

Stonefly larvae 10–25 4.0 

Catfish 20–25 2.5 

Carp 10–25 2.0 

Water boatmen 10–25 2.0 

Mosquito 10–25 1.0 
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OBJECTIVES 
• Measure the concentration of dissolved oxygen in water using an Optical DO Probe. 
• Determine the effect of temperature on the amount of dissolved oxygen in water. 
• Apply the results to predict the effect of water temperature on aquatic life. 

MATERIALS CHECKLIST  
LabQuest 
LabQuest App 
Optical DO Probe 
Temperature Probe 
two 250 mL beakers 
100 mL beaker 
polystyrene foam cup 
1-gallon plastic milk container 
hot and cold water 
ice 
goggles 

PROCEDURE 
1. Set the switch on the Optical DO Probe to the mg/L setting. The switch is located on the box 

containing the microSD card.  

2. Connect the Optical DO Probe and the Temperature Probe to LabQuest. Choose New from 
the File menu. 

3. Set up the data-collection mode. 

a. On the Meter screen, tap Mode.  
b. Change the data-collection mode to Selected Events. 
c. Select Average over 10 seconds. 
d.  Select OK. 

4. Start data collection. 

5. Obtain two 250 mL beakers. Fill one beaker with ice and cold water. Place the polystyrene 
foam cup into the second, empty beaker. 

6. Place approximately 100 mL of cold water and a couple small pieces of ice, from the beaker 
filled with ice water, into a clean plastic one-gallon milk container.  

7. Seal the container and vigorously shake the water for a period of 2 minutes. This will allow 
the air inside the container to dissolve into the water sample.  

8. Pour the shaken water into the polystyrene foam cup. 
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Figure 1    

9. Place the Temperature Probe in the polystyrene foam cup as shown in Figure 1.  

10. Place the shaft of the Optical DO Probe into the water. Make sure the silver dot on the side of 
the probe is submerged.  

11. Monitor the dissolved oxygen readings displayed on the screen. Give the dissolved oxygen 
readings ample time to stabilize (90–120 seconds).  

12. When the readings have stabilized, tap Keep. Important: Do not remove the probes until the 
10-second averaging period is complete. 

13. Remove the probes from the water sample.  

14. Pour the water from the polystyrene foam cup back into the milk container. Seal the 
container and shake the water vigorously for 1 minute. Pour the water back into the 
polystyrene foam cup. 

15. Repeat Steps 9–14 until the water sample reaches room temperature.  

16. Fill a second beaker with very warm water about 40–50 °C. When the water in the 
polystyrene foam cup reaches room temperature, add about 25 mL of the very warm water 
prior to shaking the water sample.  

17. Repeat Steps 9–14 until the water temperature reaches 35°C. 

18. When all samples have been taken, stop data collection. 

19. Tap the Table tab. Record the dissolved oxygen and temperature readings in Table 2. 

20. Create a single graph of dissolved oxygen vs. temperature to help you answer the questions.   

a. Tap the Graph tab and choose Show Graph ►Graph 1 from the Graph menu. 
b. Tap the x-axis label and select Temperature. 
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DATA 
Table 2 

Temperature 
(°C) 

Dissolved oxygen 
(mg/L) 

    

    

    

    

    

    

    

    

    

    

QUESTIONS 
1. At what temperature was the dissolved oxygen concentration the highest? Lowest? 

2. Does your data indicate how the amount of dissolved oxygen in the water is affected by the 
temperature of water? Explain. 

3. If you analyzed the invertebrates in a stream and found an abundant supply of caddisflies, 
mayflies, dragonfly larvae, and trout, what minimum concentration of dissolved oxygen 
would be present in the stream? What maximum temperature would you expect the stream to 
sustain? 

4. Mosquito larvae can tolerate extremely low dissolved oxygen concentrations, yet cannot 
survive at temperatures above approximately 25°C. How might you account for dissolved 
oxygen concentrations of such a low value at a temperature of 25°C? Explain. 

5. Why might trout be found in pools of water shaded by trees and shrubs more commonly than 
in water where the trees have been cleared? 
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Acid Rain and Its Effect 
on Surface Water  

Acid rain can be very harmful to the environment. It can kill fish by lowering the pH of lakes and 
rivers. It can harm trees and plants by burning their leaves and depriving them of nutrients. It can 
also weather away stone buildings and monuments. But why is it more of a problem in some 
places than others? 

To answer this question, let’s first look at how rain becomes acidic. Carbon dioxide, CO2, is a gas 
found naturally in the air. When CO2 dissolves into rain droplets, it produces a weak acid called 
carbonic acid, H2CO3. This makes rain slightly acidic naturally. Rain of pH 5 to 6 is common and 
does not generally cause any problems. When fossil fuels are burned, however, gases such as 
sulfur dioxide, SO2, are released into the air. When sulfur dioxide dissolves into rain droplets, 
sulfuric acid, H2SO4, is formed. This rain can be as acidic as pH 4. Figure 1 shows the trend of 
rain pH in the United States in a typical year. Notice that the most acidic rain occurs over and 
downwind from heavily populated and industrialized areas.  

Figure 1: Typical rain pH in United States. 
Acid rain is more harmful to some areas than others. This is because some water resists changes in 
pH better than others. Water that resists a change in pH is said to be buffered. Depending on the 
buffering capacity of the surface water, one area could be heavily damaged by acid rain that does 
not seem to harm another at all.  

In Part I of this experiment, you will study how rain naturally becomes acidic due to CO2 in the 
air. You will monitor the pH of water as you add CO2 by blowing through a straw. In Part II, you 
will study the effect of acid rain has on the pH of different water types. The pH will be recorded 
as sulfuric acid is added dropwise to several different types of water. 

 
OBJECTIVES 
In this experiment, you will 

• Use a pH Sensor to measure pH. 
• Study the effect of dissolved CO2 on the pH of distilled water. 
• Study the effect on pH of dissolving H2SO4 in various waters. 
• Learn why some bodies of water are more vulnerable to acid rain than others. 
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MATERIALS 
LabQuest  ring stand 
LabQuest App utility clamp 
Vernier pH Sensor straw 
100 mL beaker wash bottle with distilled water 
dilute H2SO4 soft water 
waste beaker hard water 
dropper buffer solution 

 
 
PROCEDURE 

Part I CO2 and Water 
1. Obtain and wear goggles! CAUTION: The sulfuric acid used in Part II of this experiment is a 

strong acid. Contact with sulfuric acid will damage your skin, eyes, and clothing! 

2. Connect the pH Sensor to LabQuest and choose New from the File menu. If you have an 
older sensor that does not auto-ID, manually set up the sensor. Important: For this 
experiment your teacher already has the pH Sensor in pH soaking solution in a beaker; be 
careful not to tip over the beaker when connecting the sensor to the interface. 

3. On the Meter screen, tap Rate. Change the data-collection rate to 1 sample/second and the 
data-collection length to 60 seconds. Select OK. 

4. Add 50 mL of distilled water to a clean 
100 mL beaker.  

5. Lower the pH electrode into the beaker so that 
the water is covering the glass bulb. 

6. Give a straw to the group member who will be 
blowing into the water.  

7. Start data collection. After one data pair have 
been collected, begin blowing through the 
straw into the distilled water. You may take 
breaths as needed, but try to keep a fairly 
constant stream of air going into the water. 
Data collection will stop after 60 seconds. 

8. Determine the maximum and minimum pH 
values. 
a. Choose Statistics from the Analyze menu. 
b. Record the maximum and minimum pH in 

the Part I data table. 
 
9. Print the graph as directed by your teacher. 

Figure 2 
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Part II  Effects of Acid Rain on Surface Water 
Acid Rain in Distilled Water 

 10. Set up LabQuest for data collection in the Event with Entry mode. 
a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
b. Enter the Name (Drops) and leave Units field blank. Select OK.  

 
 11. Rinse the pH electrode thoroughly with distilled water. 

 12. Wash and dry the 100 mL beaker. Get a new 50 mL portion of distilled water. Lower the pH 
Sensor into the distilled water. 

 13. Start data collection.  

 14. When the pH reading displayed on the screen stabilizes, tap Keep. Enter 0 (the number of 
drops). Select OK to save this data pair. 

 15. Add 1 drop of sulfuric acid to the water. CAUTION: Handle the sulfuric acid with care. It 
can cause painful burns if it comes into contact with skin, eyes, or clothing. 

 16. Stir thoroughly. When the pH is stable, tap Keep. Enter the number of drops of acid added to 
the beaker and select OK. 

 17. Repeat Steps 15–16, adding 1 drop at a time, until you have added 10 drops of acid.  

 18. Stop data collection.  

 19. To examine the data pairs on the displayed graph, tap any data point. As you tap each data 
point, the pH and drop number values are displayed to the right of the graph. 

 20. Record the maximum and minimum pH values in the Part II data table. 

 21. Store the data from the first run by tapping the File Cabinet icon. 

Acid Rain in Soft Water 
 22. Repeat Steps 11–21 using 50 mL of soft water instead of distilled water.  

Acid Rain in Hard Water 
 23. Repeat Steps 11–20 using 50 mL of hard water instead of distilled water. Important: Do not 

store this final run.  

 24. It is often helpful to view all three runs on one graph for comparison. 
a. Tap Run 3 and select All Runs.  
b. Print the graph or sketch it in the space below, labeling each line with the type of water 

used. 
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DATA  

Part I CO2 and Water 
Table 1 

Maximum pH Minimum pH ∆pH 

   

 

Part II  Effects of Acid Rain on Surface Water 
Table II 

 Distilled Water Soft Water Hard Water 

Maximum pH    

Minimum pH    

∆pH    

 
 
PROCESSING THE DATA 
1. Calculate the change in pH (∆pH) for the water in Part I and record in the Part I data table. 

2. Calculate the change in pH (∆pH) for each of the Part II trials and record in Part II data table. 

3. Compare the ∆pH values. Which test gave the largest pH change? Which test gave the 
smallest pH change? 

4. Hard water is said to be “naturally buffered.” From the result of this experiment, explain what 
this means. 

5. Many aquatic life forms can only survive in water with a narrow range of pH values. In which 
type of water—hard or soft—would living things be more threatened by acid rain? Explain. 



Acid Rain and Its Effect on Surface Water 

Earth Science with Vernier 16 - 5 

6. Figure 3 shows the general trend in hard and soft water in the United States. There are 
numerous coal-burning electric power plants in Illinois that produce sulfur dioxide. As the 
prevailing winds carry the pollutants northwestward, they contribute to acid rain over the 
northeast. Based on what you have learned in this lab, do you think that Ohio and New York 
will be affected the same by this acid rain? Why or why not? 

 
Figure 3: Typical water hardness as mg/L calcium carbonate 

7. A similar situation exists in Europe where air pollutants from highly industrialized Germany 
are more harmful to Scandinavian water life than to water life in Germany. Use the results of 
this experiment to predict the relative hardness and softness of Germany and Scandinavia’s 
water. 

 
EXTENSIONS 
1. Test ocean water in the same way you tested hard and soft water. How does it compare? 

2. Do library research to get more information on the effects of acid rain on streams and lakes. 
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Freezing Temperature  
of Ocean Water  

During winter in the northern hemisphere, Arctic air temperatures often dip below what we 
normally think of as the freezing point of water. Yet, while freshwater lakes freeze over, much of 
the ocean stays in liquid form rather than freezing into ice. Why doesn’t ocean water freeze at the 
same temperature as fresh water? 

In this experiment, you will use a Temperature Probe to measure the temperature of water as it 
cools and then freezes. In Part I, you will collect temperature data as you freeze fresh water and 
determine its freezing temperature. In Part II you do the same for ocean water. You will then 
compare the two freezing temperatures and hypothesize why they are different. 

 
OBJECTIVES 
In this experiment, you will 

• Observe the freezing of fresh water and ocean water. 
• Use a Temperature Probe to measure temperature. 
• Determine the freezing temperature of fresh and ocean water. 

 
MATERIALS 

LabQuest salt   
LabQuest App ice 
Temperature Probe plastic spoon 
test tube fresh water 
400 mL beaker ocean water 
ring stand   

 
PRE-LAB QUESTIONS 
1. Predict at what temperature fresh water will freeze. 

  ________ °C 

2. Predict at what temperature ocean water will freeze. 

  ________ °C 
 
PROCEDURE 
Part I  Freezing Fresh Water  
1. Connect the Temperature Probe to LabQuest and 

choose New from the File menu. If you have an older 
sensor that does not auto-ID, manually set up the 
sensor.  

Figure 1 
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2. On the Meter screen, tap Rate. Change the data-collection rate to 0.1 samples/second and the 
length to 900 seconds. Data collection will last 15 minutes. Select OK. 

3. Fill a 400 mL beaker 1/3 full with ice, then add 100 mL of water as shown in Figure 1. 

4. Put 5 mL of fresh water into a test tube and use a utility clamp to fasten the test tube to a ring 
stand. The test tube should be clamped above the water bath. Place the Temperature Probe 
into the water inside the test tube.  

5. When everything is ready, start data collection. Then lower the test tube into the ice-water 
bath.   

6. Soon after lowering the test tube, add 5 spoons of salt to the beaker and stir with a spoon. 
Continue to stir the ice-water bath.   

7. Slightly, but continuously, move the probe during the first 10 minutes of data collection. Be 
careful to keep the probe in, and not above, the ice as it forms. When 10 minutes have gone 
by, stop moving the probe and allow it to freeze into the ice. Continue to stir the ice-water 
bath. Add more ice cubes as the original ice cubes get smaller.   

8. Make and record observations as the water freezes. 

9. When 15 minutes have passed, data collection will stop. A graph of temperature vs. time will 
be displayed. To examine the data pairs on the displayed graph, tap any data point. As you tap 
each data point, the temperature values are displayed to the right of the graph. 

 10. Analyze the flat part of the graph to determine the freezing temperature of fresh water.  
a. Tap and drag your stylus across the flat portion of the graph to select the data points. 
b. Choose Statistics from the Analyze menu. The program will now calculate and display the 

statistics for the data in the region. 
c. Record the mean value as the freezing temperature in your data table. Round to the nearest 

0.1°C. 
 

 11. Store the data from the first run by tapping the File Cabinet icon.  

 12. Do not attempt to remove the Temperature Probe from the ice! Place the test tube into a 
beaker of warm water to melt the ice, then remove the Temperature Probe.  

Part II  Freezing Ocean Water 
 13. Repeat Steps 3–10, this time using ocean water instead of fresh water. You may find that you 

need to add more ice and salt to the ice-water bath to freeze the ocean water. Important: Do 
not store this run as you did in the first run—proceed directly to Step 14 after you complete 
Step 10. 

 14. A good way to compare the freezing curves is to view both sets of data on one graph. To do 
this, tap Run 2 and choose All Runs. 

 15. Do not attempt to remove the Temperature Probe from the ice! Place the test tube into a 
beaker of warm water to melt the ice, then remove the Temperature Probe.   

 16. Sketch or print the graph as directed by your teacher. Label the lines “Fresh Water” and 
“Ocean Water” and write the freezing temperatures on your graph. 
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OBSERVATIONS 
Part I  Freezing Fresh Water  
 
 
 
 
Part II  Freezing Ocean Water  
 
 
 
 
DATA 

 Part I 
Fresh Water 

Part II 
Ocean Water  

Freezing Temperature (°C)   

 
 
PROCESSING THE DATA 
1. Describe the shape of each graph. 
 Part I – Fresh Water  

 
 
 Part II – Ocean Water  

 
 
2. What was happening to the water during the flat portion of each graph? 

3. Based on your data, which type of water has to get colder in order to freeze, fresh water or 
ocean water? 

4. In some areas, icy roads are “salted” to make them safer for drivers. Use your data to explain 
why this is an effective method. 

 
EXTENSIONS 
1. Ocean water has a salinity of about 35 ppt. Design and conduct an experiment to determine 

the freezing temperature of water with different concentrations of salt.  

2. Freshwater streams and rivers can also stay in liquid form below the normal freezing 
temperature of water. Design and conduct an experiment to examine this phenomenon.  
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PRELIMINARY ACTIVITY FOR 
Insulation Study 

Insulation is an important component of energy-efficient buildings. Insulation reduces both the 
energy required for wintertime heating and summertime cooling. Fiber glass, rock wool, cellulose, 
polyurethane foam, polystyrene foam, and foil-faced paper, polyethylene bubbles, and plastic film 
are common insulation materials. Basic insulation forms include blanket (batts or rolls), loose-fill, 
spray-applied, rigid insulation, and reflective systems. 

In the Preliminary Activity, you will monitor the temperature of a bottle of warm water as it cools 
for three minutes and determine its cooling rate.  

After completing the Preliminary Activity, you will first use reference sources to find out more 
about insulation before you choose and investigate a researchable question. Some topics to 
consider in your reference search are: 

• insulation 
• thermal insulation 
• R-value 
• energy efficiency 
• energy-efficient technologies 
• superinsulation 

 
Later, you will use the class research results as you insulate the bottle in preparation for a contest 
to see which group can make the best-insulated bottle, as determined by lowest cooling rate. 

 
PROCEDURE 
1. Connect the Temperature Probe and the data-collection interface.  

2. Obtain a small bottle and a one-hole rubber stopper that fits the bottle. 
Insert the Temperature Probe into the rubber stopper. 

3. Fill the bottle with hot tap water. Insert the rubber stopper and 
Temperature Probe into the bottle.  

4. Observe the temperature readings. When the readings begin to drop, start 
data collection. 

5. When data collection stops, use the Linear Fit function to determine the 
cooling rate (slope). Record the cooling rate (in ºC/s). 

 
QUESTIONS 
1. What was the cooling rate of your water in the Preliminary Activity? 

2. Identify two materials commonly used to insulate homes in your area. 

3.  List at least one researchable question for this experiment. 
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Product Name Order Code (Price) Device 
Compatibility Use 

Celestron Digital 
Microscope Imager 

CS-DMI ($79) Computer 
Chromebook 
LabQuest 2 

 Existing 
Microscopes 

 Replaces an 
eyepiece 
 

USB Digital 
Microscope 

BD-EDU-100 ($119) Computer 
Chromebook 
LabQuest 2 

 Stand alone 
 Independent light 

source 

ProScope Micro 
Mobile Microscope 

BD-PMM ($149) iPad 
iPhone 

iPod Touch 
Galaxy S4 

 Uses imaging apps 
on mobile device 

 Independent light 
source 

 Different sleeve for 
each device 

ProScope 5MP 
Microscope Camera 

BD-PS-MC5UW ($299) Computer 
Chromebook 
iOS Devices 

Android Devices 

 Existing 
Microscopes 

 Replaces an 
eyepiece 

 Connects to iOS 
and Android 
devices via Wi-Fi 

 Connects to 
computers and 
Chromebooks via 
USB 
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